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1. Introduction 
In the strategy for growth "Europe 2020" as a primary objective is set providing smart, 

sustainable and inclusive growth of the economy in all European countries [1]. One of the key 
initiatives of the strategy is the "Open education" that aims to stimulate high-quality, 
innovative ways of learning and training through new technologies and digital content [2]. In 
the open and flexible training fully exploit the potential of ICT to improve the systems for 
training and education of students, and thus increases the efficiency of education, which leads 
to better use of resources and improving knowledge. Inside the initiative is built a portal 
OpenEducationEuropa1, designed to assist users (teachers and students) in finding the needed 
open educational resources (OER) and improve the visibility of the many resources of high 
quality, produced in Europe [3]. 

The development of educational materials is an important stage in learning and 
teaching. The good educational resources help students develop their ability to understand 
concepts, ideas and objectives of operations. The ability of each student to access the Internet 
and the shared resources is the basis of the use of OER. 

According [4] Open Educational Resources (OER) are “digitized materials offered 
freely and openly for educators, students and self-learners to use and re-use for teaching, 
learning and research.” This term was first adopted at UNESCO’s 2002 Forum on the Impact 
of Open Courseware for Higher Education in Developing Countries funded by the Hewlett 
Foundation. 

Another definition for OER, proposed by The William and Flora Hewlett Foundation 
[5] states: "OER are teaching, learning and research resources that reside in the public domain 
or have been released under an intellectual property license that permits their free use or re- 
purposing by others. Open educational resources include full courses, course materials, 
modules, textbooks, streaming videos, tests, software, and any other tools, materials or 
techniques used to support access to knowledge." 

Nowadays the creation of OER is one of the key focuses for instructors and students. 
The main characteristics of OER we can point from the definition given by UNESCO [11] 
where the following issues could be highlighted: 

• teaching, learning and research materials in any medium, digital form or otherwise; 
• reside in the public domain or under an open license; 
• permit no-cost access, use, adaptation and redistribution by others with no or limited 

restrictions. 
Some researches study the usage of OER in the field of foreign language education. 

The web-based teaching, with modern information technology such as the use of online tools 
and web-based open educational resources in developing good academic practice on learning 
Business English can prove effective as long as the strategies fit the students' needs and 
enhance their motivation for learning and for using such educational Internet-based 
technology and also as long as they are used in accordance with the students' proficiency level 
and interests [6]. The US continues to be somewhat hesitant to fully embrace materials and 
tools such as OER in foreign language programs where the system of tool creation and 
material publication on which education in most disciplines is built still relies largely on 
traditional textbooks and delivery methods [10] 

OER are usually accompanied by digital copyright licenses allowing their use for their 
own purposes and sharing learning resources. Thus the network of content developers of OER 
can practically become unlimited. 

 
 

 

1 OpenEducationEuropa.eu 
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Internet is becoming one of the main sources of information and knowledge for today's 
students. Open educational resources created in the first place with the support of universities 
provide users the ability to use high-quality educational materials. With the use of OER the 
educational system undergoes a qualitative change as a result of changes in the way the actual 
content and teaching methods, and tools, environments and ways of disseminating knowledge. 
All this leads to transformation of the educational model which allows movement from 
studying ICT to learning by using ICT. The presence of a huge number of open educational 
resources with free access motivates trainers to create and use training courses with high 
quality and students may compare and evaluate the available teaching materials. 

Recommendations for a greater use of ICT tools and OER in teaching can be placed as 
the next topics. 
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2. Overview of the top OER tools 
2.1. Why to use OER 
The goal of OER is to improve access to learning opportunities by sharing knowledge 

and learning resources. By joining this international community of educators you can save 
time, cut costs and contribute to improving the quality of learning in your own classroom and 
around the world. The OER movement seeks to stimulate, facilitate and catalyze growth of 
the pool of learning resources on the Internet which circumvent barriers to access and lift 
restrictions on usage [20], thus improving education as a social good. With OER you are free 
to use, adapt, mix and share the resources, and become part of this growing community. 
Because of all these you can list as basic reasons for OER use the following [16]: 

• freely accessible for use by anyone; 
• presented in a format that users can adapt for their own context; and 
• framed within a licensing system that makes adapters responsible for sharing their use 

of the resources with the wider community. 

2.2. Design of OER 
Open Educational Resources (OER) are teaching and learning materials that may be 

freely used and reused at no cost. Unlike to traditional closed-copyright resources, OER have 
been designed or created by an individual or organization who have some ownership rights. In 
some cases, that means you can download a resource and share it with colleagues and students 
[17]. 

In other cases, OER may be able to be downloaded, edited in some way, and then re- 
post it as a remixed work. OER often have a Creative Commons or GNU license to let you 
know how the material may be used, reused, adapted, and shared. 

Before starting the creation and design of OER we need to put a basic question: What 
aims and objectives we set, and consequently, what outcomes are expected in the use of OER? 

The difference between aims and objectives is that the aim is the general statement of 
what you hope the course will achieve, usually expressed in terms of what you will be 
presenting in the course; the objectives are what you intend the learner to be able to know, 
understand and do once they have studied the course [18] 

The model, described by David Wiley, can be used. According to that model the 
development of OER can be presented as development lifecycle [19]. The following sequence 
of steps illustrates a typical development process (figure 1). 

• Find: start by looking for suitable resources which contribute to meeting the need or 
satisfying the desire. This may include using general search engines, searching specific 
repositories and finding individual websites. Some potential components may be 
available offline, including last year's lecture notes, class projects, handouts for 
learners and other resources prepared previously. 

• Compose: with a collection of resources at your disposal, start piecing them together 
to form a learning resource for yourself, your fellow educators and/or learners. This is 
a creative design process of building an educational resource from scratch and/or 
using components you have found. 

• Adapt: while composing OER, it will nearly always be necessary to adapt components 
to your local context. This may involve minor corrections and improvements, 
remixing components, localization and even complete rework for use in diverse 
contexts. 
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• Use: the actual use of OER in the classroom, online, during informal learning 
activities, etc. 

• Share: once an OER is finished, make it available for the open education community 
to re-use and begin the life cycle again. 
Licensing also plays a role throughout the life cycle. 

 

 
 

Fig.1 Life cycle of the development of the OER [19] 
 

This life cycle applies to the development of an individual OER as well as large OER 
projects. Each of these stages has their own unique considerations. Although the life cycle 
follows a logical progression, it is not necessarily followed sequentially in practice. Some 
parts, such as adaptation, can be done simultaneously with other parts or out of order. 

When creating the ONE it is necessary to use tools, with which we can build the 
following three important components [17]: 

• Create media rich documents - use tools that allow the creation and make it easy to 
combine text, pictures, sounds, files, and video, and save them as openly licensed 
educational resources. These resources which can then be shared with friends, 
colleagues and educators from around the world. With those tools, you also can 
organize, edit and publish resources that are suitable to you and your classroom. 

• Create interactive lessons – use tools that allow authors to create both student and 
teacher facing content views. Authors are encouraged to include overviews, 
pedagogical supporting text, and instructions for both students and other users of the 
resource. The interactive lesson consists of sequenced tasks, which can incorporate a 
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step-by-step approach to learning. Each task can have associated resources available 
for download. 

• Create interactive modules - use tools that allow authors to create both student and 
instructor facing content views. Authors are encouraged to include overviews, 
pedagogical supporting text, and instructions for both students and other users of the 
resource. The interactive modules can consist of sequenced tasks, which can 
incorporate a step-by-step approach to learning. Each task can have associated 
resources available for download. 

2.3. Finding suitable OERs 
During the search process of most appropriate OER for given aims, objectives and 

specific disciplines, where the resources will be used it is necessary to observe the 
characteristics of these resources. According [18] а good OER is that, which has the following 
characteristics: 

• findable – each OER can be in multiple locations 
• clearly described 
• clearly licensed (normally through Creative Commons) 
• from a source you trust 
• easy to modify 
• free-standing – it does not assume knowledge of other resources 
• free of copyright content 
• being used by/recommended by people like you 
• imperfect – it just needs to work for you. 
When seeking content for adaptation and re-use in open educational contexts there are 

several tools available to support discovery. Many of these tools are result of experimental 
prototyping and short-term funded projects, however, and therefore they carry with them a 
certain amount of risk. Not all are sustained beyond the life of the funding, but  these initiatives 
have sought to use a variety of search technologies to support the discovery of generic 
and domain-specific OERs. As we move forward with search technologies based on increased 
application of semantic approaches to discovery, things should hopefully improve for the end 
user [21]. 

Mostly Google’s Advanced Search is being used to find an OER in an area that 
interests the user. It allows him to restrict the results to Creative Commons licensed material 
by setting the filter in the ‘usage rights’ field to ‘free to use, share or modify’. After that the 
table supplied is being filled in, which includes the list of characteristics of a good OER, to 
assess how well the found resources meet the criteria for a good OER. 

Two key resources that have brought together several aspects of working with OERs 
and contain sections on searching and evaluating have been published by JISC and 
WikiEducator [22, 23]. While these resources contain links to specific search tools that can be 
queried, the most effective start for finding discipline-specific OER is to query the specific 
open content repositories that have been built to support communities committed to working 
with open content. 

The UK national repository for supporting work in this field is the Jorum [24]. The 
various jointly funded JISC/HEA projects have deposited all their outputs in Jorum and the 
repository continues to grow in terms of assets created and licensed for re-use for learning, 
teaching and research. Jorum results are now fully open. 

End users searching for very specific requirements tailored to meet national or regional 
needs for licensed open content are frequently better served visiting and querying national 
repositories built to serve such needs. Exemplar repositories such as Jorum that operate 
within the constraints and needs of regional and national boundaries often still make 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

6 

 

 

 
 

their content globally open for discovery and reuse. The perceived and actual value of this 
content will always be driven by the specific needs of the end user. Our broader global 
communities building, managing and repurposing this content will only ever reap the full 
value through users proactively engaging in feedback, enhancements and re-deposit of 
alternative versions, flexibly licensed for further reuse. The process of finding and evaluating 
OER will only ultimately improve through engagement and sharing, the key philosophy 
behind the movement itself. 

For the purposes of this research many OER, available on the web, are explored and 
examined. The information is presented in Table 1: 

 
Table 1: OER tools 

 
Tool Name 

 
Website 

MasteryConnect https://www.masteryconnect.com/ 
Adobe Acrobat DC – 
BACK www.adobe.com/products/acrobatpro/ 

Adobe Captivate www.adobe.com/products/captivate.html 
Adobe Connect www.adobe.com/products/adobeconnect.html 
Adobe Photoshop www.adobe.com/products/photoshop 
Animoto https://animoto.com/ 
Articulate Storyline www.articulate.com 
Audacity audacity.sourceforge.net/ 
AudioBoo https://audioboom.com/ 
Aviary https://www.aviary.com/ 
Blackboard Collaborate www.blackboard.com/platforms/collaborate/overview.aspx 
Blackboard Learn blackboard.com/platforms/learn.aspx 
Blogger www.blogger.com 
Camtasia www.techsmith.com/camtasia.html 
Canva – NEW http://canva.com 
Canvas www.instructure.com 
Capzles http://www.capzles.com/ 
CarrotSticks http://www.carrotsticks.com (not working) 
Coursera www.coursera.org 
Creaza http://web.creaza.com/en/ 
Delicious delicious.com 
Diigo https://www.diigo.com/ 
Dropbox https://www.dropbox.com/ 
Easygenerator www.easygenerator.com 
Edmodo https://www.edmodo.com/ 
Elluminate http://www.elluminate.com/ 
Edpuzzle www.edpuzzle.com 
EduBlogs http://edublogs.org/ 
Educreations https://www.educreations.com/ 
edX – NEW http://edx.org 
ePals http://www.epals.com/#/connections 
Evernote evernote.com 
Excel office.microsoft.com/excel 

https://www.masteryconnect.com/
http://www.adobe.com/products/acrobatpro/
http://www.adobe.com/products/captivate.html
http://www.adobe.com/products/adobeconnect.html
http://www.adobe.com/products/photoshop
https://animoto.com/
http://www.articulate.com/
http://audacity.sourceforge.net/
https://audioboom.com/
http://www.aviary.com/
http://www.aviary.com/
http://www.blackboard.com/platforms/collaborate/overview.aspx
http://blackboard.com/platforms/%20learn.aspx
http://www.blogger.com/
http://www.techsmith.com/camtasia.html
http://canva.com/
http://www.instructure.com/
http://www.capzles.com/
http://www.carrotsticks.com/%20(N/A)
http://www.coursera.org/
http://web.creaza.com/en/
http://www.delicious.com/
http://www.diigo.com/
http://www.diigo.com/
http://www.dropbox.com/
http://www.dropbox.com/
http://www.easygenerator.com/
http://www.edmodo.com/
http://www.elluminate.com/
http://www.edpuzzle.com/
http://edublogs.org/
http://edublogs.org/
https://www.educreations.com/
http://edx.org/
http://www.epals.com/%23/connections
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Explain Everything www.explaineverything.com 
Facebook www.facebook.com 
Feedly feedly.com 
Flickr http://www.flickr.com/ 
Firefox & Add-ons www.mozilla.com/firefox/ 
Flipboard www.flipboard.com 
FunBrain http://www.funbrain.com/ 
Glogster http://edu.glogster.com/?ref=personal 
Gmail gmail.com 
GoAnimate – NEW www.goanimate.com 
Google + plus.google.com 
Google Chrome & Apps www.google.com/chrome 
Google Docs/Drive www.google.com/docs 
Google Earth http://www.google.com/earth/index.html 
Google Education https://www.google.com/edu/ 
Google Hangouts hangouts.google.com 
Google Maps maps.google.com 
Google Scholar scholar.google.com 
Google Search www.google.com 
Google Sites sites.google.com 
Google Translate www.google.com/translate 
Grockit https://grockit.com/ 
Haiku Deck www.haikudeck.com 
IFTTT www.ifttt.com 
iMovie – BACK http://www.apple.com/mac/imovie/ 
Instagram www.instagram.com 
iPad and Apps www.apple.com/ipad 
iSpring Suite www.ispringsolutions.com 

iTunes and iTunesU iTunes: www.apple.com/itunes/ 
iTunesU: www.apple.com/education/itunes-u/ 

Jing https://www.techsmith.com/jing.html 
Kahoot www.getkahoot.com 
Kerpoof http://lol.disney.com/kerpoof 
Keynote www.apple.com/iwork/keynote/ 
Khan Academy https://www.khanacademy.org/ 

Kindle & App Kindle App: https://www.amazon.com/gp/digital/fiona/kcp- 
landing-page?ie=UTF8&ref_=klp_f_win 

Knewton https://www.knewton.com/ 
Lectora Inspire lectora.com 
LinkedIn www.linkedin.com 
LiveBinders http://www.livebinders.com/ 
MangaHigh https://www.mangahigh.com/en/en_us/ (N/A) 
Mentimeter – NEW www.mentimeter.com/ 
Mentor Mob https://www.mentormob.com/ 
Moodle www.moodle.org 

Movie Maker – BACK http://windows.microsoft.com/en- 
US/windows7/products/features/movie-maker 

Nearpod www.nearpod.com 

http://www.explaineverything.com/
http://www.facebook.com/
http://www.flickr.com/
http://www.mozilla.com/firefox/
http://www.flipboard.com/
http://www.funbrain.com/
http://edu.glogster.com/?ref=personal
http://www.goanimate.com/
http://www.google.com/chrome
http://www.google.com/docs
http://www.google.com/earth/index.html
http://www.google.com/edu/
http://www.google.com/edu/
http://www.google.com/
http://www.google.com/translate
https://grockit.com/
https://grockit.com/
http://www.haikudeck.com/
http://www.ifttt.com/
http://www.apple.com/mac/imovie/
http://www.instagram.com/
http://www.apple.com/ipad
http://www.ispringsolutions.com/
http://www.apple.com/itunes/
http://www.apple.com/education/itunes-u/
http://www.techsmith.com/jing.html
http://www.getkahoot.com/
http://lol.disney.com/kerpoof
http://www.apple.com/iwork/keynote/
https://www.khanacademy.org/
http://www.amazon.com/gp/digital/fiona/kcp-
http://www.amazon.com/gp/digital/fiona/kcp-
https://www.knewton.com/
http://www.linkedin.com/
http://www.livebinders.com/
https://www.mangahigh.com/en/en_us/%20(N/A)
http://www.mentimeter.com/
https://www.mentormob.com/
http://www.moodle.org/
http://windows.microsoft.com/en-
http://www.nearpod.com/
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Ning http://www.ning.com/ 
Notability www.gingerlabs.com 
Office Mix – NEW https://mix.office.com/ 
OneNote onenote.com/ 
OpenStudy http://openstudy.com/ 
Outlook outlook.com 
Padlet www.padlet.com 
Piktochart – NEW http://piktochart.com 
Pinterest https://www.pinterest.com/ 
Planboard https://www.planboardapp.com/ 
Pocket www.getpocket.com 
Poll Everywhere www.polleverywhere.com 
Popplet http://popplet.com/ 
PowerPoint www.microsoft.com/powerpoint 
PowToon www.powtoon.com 
Prezi https://prezi.com/ 
QR Codes N/A 
Quizlet https://quizlet.com/ 
Quora https://www.quora.com/ 
Schoology https://www.schoology.com/ 
Scoopit www.scoop.it 
Screencast-O-matic – 
BACK www.screencastomatic.com 

SharePoint www.sharepoint.com 
Skype https://www.skype.com/en/ 
Slack – NEW http://slack.com 
SlideShare http://www.slideshare.net/ 
Snagit www.techsmith.com/snagit.html 
Socrative www.socrative.com 
SoftChalk http://www.softchalk.com 
StudySync http://www.studysync.com/our-product/what-is-studysync/ 
SurveyMonkey SurveyMonkey.com 
Sway – NEW https://sway.com/ 
TED Talks/Ed http://ed.ted.com/ 
ThingLink – NEW http://thinglink.com 
Timetoast http://www.timetoast.com/ 
Todays Meet todaysmeet.com 
Trello – BACK www.trello.com 
Tweetdeck www.tweetdeck.com 
Twitter https://twitter.com/ 
Udemy – NEW www.udemy.com 
Udutu – NEW www.udutu.com 
Videoscribe – NEW www.videoscribe.co 
Vimeo www.vimeo.com 
VoiceThread http://www.voicethread.com 
WebEx www.webex.com 
WhatsApp www.whatsapp.com 
Wikipedia www.wikipedia.org 

http://www.ning.com/
http://www.ning.com/
http://www.gingerlabs.com/
http://openstudy.com/
http://openstudy.com/
http://www.padlet.com/
http://piktochart.com/
http://pinterest.com/
http://www.pinterest.com/
http://www.pinterest.com/
https://www.planboardapp.com/
http://www.getpocket.com/
http://www.polleverywhere.com/
http://popplet.com/
http://www.microsoft.com/powerpoint
http://www.powtoon.com/
https://quizlet.com/
http://www.quora.com/
https://www.quora.com/
https://www.schoology.com/home.php
http://www.schoology.com/
http://www.schoology.com/
http://www.scoop.it/
http://www.screencastomatic.com/
http://www.sharepoint.com/
http://www.skype.com/intl/en-us/home
http://www.skype.com/en/
http://www.skype.com/en/
http://slack.com/
http://www.slideshare.net/
http://www.techsmith.com/snagit.html
http://www.socrative.com/
http://www.softchalk.com/
http://www.studysync.com/our-product/what-is-studysync/
http://ed.ted.com/
http://thinglink.com/
http://www.timetoast.com/
http://www.trello.com/
http://www.tweetdeck.com/
http://www.udemy.com/
http://www.udutu.com/
http://www.videoscribe.co/
http://www.vimeo.com/
http://www.voicethread.com/
http://www.webex.com/
http://www.whatsapp.com/
http://www.wikipedia.org/
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Wikispaces http://www.wikispaces.com/ 
Word www.microsoft.com/word 
Wordle http://www.wordle.net/ 
WordPress www.wordpress.com and wordpress.org 
Yammer www.yammer.com 
YouTube www.youtube.com 

2.4. Choice of criteria for OER analysis 
The analysis is based on three main sources of OER: top 100 tools for learning 2015 

by Jane Hart, which compiled the votes of over 2,000 learning professionals (from education 
and enterprises) worldwide, 50 education technology tools every teacher should know about 
by GDC Team and the Web 2.0 Tools in Education [12,13,14, 15]. After merging these lists 
of tools and elimination of repetitions, 131 current tools for OER design emerged. 

The OER tools that have been studied for this report were categorized into the key 
areas that were defined in the analysis prepared by the participants’ tools for the OER 
creation. Table 2 shows the 55 tools in first category - Content-based resources. 
Table 2: Content-based resources 

 
Tool Name Description 

Adobe Acrobat 
DC 

Adobe Acrobat DC (Document Cloud) lets you create, combine, and  control Adobe 
PDF documents for easy, more secure distribution, collaboration, and data 
collection. It is particularly useful for create interactive training materials. 

Adobe 
Captivate 

Adobe Captivate is a popular tool for rapidly creating and maintaining interactive 
eLearning content. 

Adobe 
Photoshop 

Photoshop is a photo imaging tool for both professional and serious amateur 
photographers as well as graphic and web designers 

Animoto Animoto makes it simple to create video-based lessons or presentations for the 
classroom and to share them with students or anyone else. 

Articulate 
Storyline 

Articulate’s Storyline is the highest rated e-learning authoring tool on the list. 

Audacity Audacity is a free open source tool to record, edit and mix sounds. It has been a 
long time favourite on the list. 

AudioBoo Through this tool, you can record and share audio for your students or anyone 
else. 

Aviary Aviary is a suite of tools that make it easy to edit images, effects, swatches, music, 
and     audio     or      to      create      and      modify      screen      captures. Aviary 
is a free suite of online creative applications, from graphic design to audio editing, 
which can be used right in the web browser. 

Blogger Google-owned Blogger is still seen as a quick and easy way to start and maintain a 
blog. 

Camtasia Techsmith’s Camtasia is a tool to record, edit and enhance on-screen activity in 
the form of screencasts. 

Canva Canva is an amazingly simple graphic design tool. 

Easygenerator Easygenerator is an all-in-one elearning authoring app to create courses in the 
cloud. 

Edpuzzle EDpuzzle lets you take any video off the web, edit it, add notes and questions for 
students, and create virtual classrooms where you can monitor student work 

http://www.wikispaces.com/
http://www.wikispaces.com/
http://www.microsoft.com/word
http://www.wordle.net/
http://www.wordpress.com/
http://www.yammer.com/
http://www.youtube.com/
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Educreations Educreations is an amazing online tool for the iPad that lets teachers (or students) 
create videos that teach a given topic. Perfect for studying or getting students to 
show off their knowledge. 

Excel Excel is used for a variety of reasons – from a gradebook to a training 
management system. It is available as part of the Microsoft Office suite to 
download or online as part of Office365 

Explain 
Everything 

Explain Everything is an interactive whiteboard app that lets you annotate, 
animate, narrate, import, and export almost anything to and from almost 
anywhere. 

FunBrain If you’re looking for a great collection of educational games, look no further than 
FunBrain. On it, teachers can take advantage of fun tools for math and reading. 

Glogster Glogster is a social site that lets users mash up music, photos, videos, and pretty 
much anything else you’d like. It’s a great way to create learning materials and a 
handy tool for creative student projects. 

GoAnimate GoAnimate is an easy-to-use tool to create professional animated videos. 

Google 
Docs/Drive 

Through Google Docs, teachers can create and share documents, presentations, or 
spreadsheets with students and colleagues as well as give feedback on student- 
created projects. You can use Google Docs to create personal documents, 
spreadsheets, slidesets, as well as share them with others or work collaboratively 
on them. 

Google Earth From geography projects to learning about geological processes, Google Earth can 
be an amazing and fast way to show students anywhere in the world. 

Google Maps Google Maps are searchable and zoomable maps of the world.  You can find 
businesses, get directions, and even embed maps in your website. 

Google Scholar Google Scholar provides a simple way to search broadly for scholarly literature. 

Google Search Google is a powerful search engine.  Often described as the only e-learning tool 
you’ll ever need. 

Google 
Translate 

Google Translate is a free online service for instantly translating text and web 
pages. 

Haiku Deck Haiku Deck is presentation software. It makes telling your story simple, beautiful 
and fun 

Instagram Instagram lets you take a picture or video, choose a filter to transform its look and 
feel, and then post it. You can also share it on Facebook, Twitter and other places. 

iSpring Suite iSpring Suite is e-learning authoring software that integrates with PowerPoint to 
create e-learning course and video lectures. 

iTunes and 
iTunesU 

iTunes is a digital media player that lets you that lets you organize your music, 
movies, TV shows, and more on your Mac or PC, then add it to your iPod, iPhone 
or iPad. iTunesU is a section of Apple’s iTunes Music Store that features free 
educational audio and video from universities and other organizations to 
download. 

Jing If you’re teaching kids about tech or just about anything else, a great screenshot 
program is essential. Jing is one great option that allows teachers to take 
screenshots as images, record up to five minutes or videos then edit and share the 
results. Techsmith’s Jing is a free screencasting program that lets you capture 
anything you see on your computer screen, as an image or short video, and share it 
instantly. 

Kerpoof On Kerpoof, students can get creative with their learning with games, interactive 
activities, drawing tools, and more that are both fun and educational. 

Lectora 
Inspire 

Lectora Inspire is an e-learning authoring tool.  It provides users with an authoring 
environment for creating and delivering interactive multimedia content. 
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LiveBinders Like a real-life three ring binder, this tech tool allows you to collect and organize 
resources. Much better than a binder, however, the site also comes with tools to 
connect and collaborate and a virtual whiteboard. 

MangaHigh MangaHigh  offers  teachers  a  wealth  of  resources  for  game-based  learning in 
mathematics. 

Movie Maker Windows Movie Maker makes home movies amazingly fun. With Movie Maker 
you can create, edit, and share your home movies right on your computer. 

Notability Notability is a note-taking app for mobile devices and the desktop. It supports text, 
images, and audio recordings, and contains a sketchpad that lets you draw images 
as well as mark up images, Web clips, and clip art. 

Office Mix A free PowerPoint add-in to create and share interactive online videos. 

OneNote OneNote is note-taking software for capturing all of your ideas and to-dos on the 
go, brought to you by Microsoft Office. 

Piktochart Piktochart is an easy-to-use design app that requires very little effort to produce 
beautiful, high quality infographics. 

Pocket Pocket lets you save pages on your computer or smartphone. so that you can read 
later, at home or work –  even without an internet connection. 

Popplet You and your students can use Popplet to brainstorm ideas, create mindmaps, 
share, and collaborate. 

PowerPoint Microsoft’s PowerPoint is a key tool for creating personal presentations as well as 
linear e-learning content. 

PowToon PowToon is an online software tool that allows you to create animated video 
explainers – for business or education 

Prezi Want to build presentations that will wow your students? Make use of this online 
tool that makes it simple to do all kinds of cool things with your lessons, even 
allowing collaboration between teachers. 
Prezi is seen as an alternative to PowerPoint in that it supports the creation of non- 
linear presentations. They are also easily shareable online. 

Screencast-O- 
matic 

Screencast-O-Matic  makes  screencasting  free  and  easy,  with  one-click  screen 
capture, online or you can download and install the application on Mac OSX. 

Snagit Techsmith’s Snagit is a screen capture tool that lets you grab an image or video of 
what you see on your computer screen and then add enhancing text and other 
effects. 

SoftChalk SoftChalk is content authoring software for educators in schools, colleges and 
universities to create interactive lessons. 

Sway Microsoft’s Sway is a free app to create web content. You can embed a variety 
of resources into Sway, e.g. images, audio, video, maps, animations, presentations 
from Office Mix etc, and then share it online. 

Timetoast Timetoast is a pretty cool for student projects, allowing them to build sleek, 
interactive timelines in minutes. 

Udutu Udutu’s course authoring software lets you build course quickly and easily online 
either on your own or collaboratively with others 

Videoscribe Videoscribe lets you create your own whiteboard-style animations with no design 
or technical know-how 

VoiceThread VoiceThread is an Internet-based application that allows users to create a shared 
presentation as a media album that visitors can asynchronously comment on either 
by text, voice, or video. The presentation can include any form of digital media, 
including images, audio, video, and text 
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Word Word is a popular and versatile word processing tool used for creating all kinds of 
paper-based materials. It is available as part of the Microsoft Office suite to 
download or online as part of Office365. 

Wordle Create stunning word clouds using Wordle, a great complement to language 
lessons of any kind. Wordle lets you generate word clouds from text that you 
provide. You can tweak your clouds with different fonts, layouts, and colour 
schemes. 

YouTube Not all schools allow YouTube, but they are missing out as the site contains a 
wealth  of  great  learning  materials  for  the  classroom.  There’s  even   a special 
education-focused    channel just     for     teachers     and     students. This video 
hosting site is seen both as a key learning resource and a place for anyone to 
share their own video content. 

 

The section “Content-based resources” involves two main directions: authoring tool 
and useful tools. The first one helps instructors and students to design and create different 
learning objects for course authoring. For the creation of the smallest learning object many 
tools and services for OER exist and Google offers most of them. There are some tools which 
help in creation of video resources and some of them are being used for game objects. 

The next big category is Dialogue & Collaborative which is being separated in 
following sections: Social Learning and Useful Tools and Browser (Table 3, 49 tools). One of 
the most widely used method in Dialogue & Collaborative is the use of emails. In fact you can 
see that most tools are for sending and receiving mails. 
Table 3: Dialogue & Collaborative 

 

Tool Name Description 
Adobe 
Connect 

Adobe Connect is web conferencing software for web meetings and webinar events – 
and the most popular one on the list 

Blackboard 
Collaborate 

Blackboard Collaborate offers a social, interactive learning experience with virtual 
classrooms, online conferencing and instant messaging. Previously known as 
Elluminate. 

Delicious Delicious is a free tool to discover save, organize and share interesting links on the 
Web. Its popularity has waned with the advent of more visual bookmarking tools. 

Diigo Diigo lets you treat the web like paper-based reading material, making it simple to 
highlight,     bookmark,     take     notes,     or     even     add     sticky     notes. Diigo 
is a social bookmarking, research and knowledge sharing tool. It lets you make 
personal notes and highlight text on web pages and share them with others. 

Dropbox Easily store, share, and access any kind of data from anywhere with the easy-to-use 
and free Dropbox service. Dropbox has become an important tool for sharing files 
both publically and privately, both in companies and education 

Edmodo Teachers and students can take advantage of this great tech tool, as it offers a 
Facebook-like     environment     where     classes     can     connect     online. Edmodo 
is a private social platform for teachers and students to share ideas, files, events 
and assignments. 

EduBlogs EduBlogs  offers  a  safe  and  secure  place  to  set  up  blogs  for  yourself  or  your 
classroom. 

Elluminate Elluminate provides web, audio, video, and social networking solutions optimized 
for 21st century education and training. Elluminate is a virtual classroom or web 
conferencing application developed by Elluminate Inc. (Elluminate.com). It presents 
an interface where learners can view and share screens and presentations It facilitates 
communication via audio and text chat. 
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ePals One of the coolest benefits of the Web is being able to connect with anyone, 
anywhere. ePals does just that, but focuses on students, helping them to learn 
languages and understand cultures different from their own. 

Evernote Capture great ideas, photos, recordings, or just about anything else on your Evernote 
account, access it anywhere, and keep it organized. A must-have tool for lesson 
planning. 
Evernote is the leading note-taking tool – not just for textual notes but also for web 
clipping. It can also be used across mobile computing devices. Notebooks are also 
shareable. 

Facebook Although primarily used by individuals for personal networking, it is also seen as a 
useful tool within education to support both study groups and course sites. 

Feedly Feedly is an RSS reader that lets you organize, read and share the content of your 
favourite sites. It is now the only dedicated feed reader on the list. 

Flickr Flickr is a photo-sharing site/service where anyone can upload and tag  photos, browse 
others’ photos, and add comments and annotations. Flickr provide an opportunity   
for   students   studying   photography    or    other    art-related subjects to receive 
feedback and engage with a community of experts and amateur enthusiasts, exposing 
students to the reality of professional practice. 

Firefox & 
Add-ons 

Firefox is an award winning, open source browser. There are also thousands of add- 
ons that enhance its functionality. 

Flipboard Flipboard is a social magazine, available for iPad, iPhone and Android devices, that 
curates content from your own feeds and other places. 

Gmail Gmail is a free web-based email service from Google. Also part of the Google Apps 
suite. It is still the most popular email client on the list. 

Google + Google’s social networking site is useful for deep conversations, resource sharing 
and for creating communities around topics and events. 

Google 
Chrome & 
Apps 

Google Chrome is still the top rated web browser. Chrome can be used across 
multiple platforms, and there are now many plugins and extensions available to 
extend its functionality. 

Google 
Education 

Google offers a number of great edtech resources for teachers, including email and 
collaborative apps, videos, lesson plan search, professional development, and even 
educational grants. 

Google 
Hangouts 

Google Video Hangouts are for small groups, whilst Hangouts On Air are live events 
for larger groups that are streamed via YouTube. 

Google Sites Google Sites lets you create simple, secure group websites. Share information with a 
few people, a whole organization, or the entire world. 

Grockit Get your students connected with each other in study sessions that take place on this 
great social site. 

IFTTT IFTTT is a service that lets you create powerful connections between social channels 
with one simple statement: If This Then That 

iMovie iMovie for Mac lets you enjoy your videos like never before. Browse your clips 
easily, instantly share your favorite moments. You can even start editing on iPhone 
or iPad, and finish on a Mac. And when you’re ready to premiere your movie on all 
your devices, iMovie Theater rolls out the red carpet. 

LinkedIn LinkedIn is seen as a prime professional networking service, for connecting with 
others professionally as well as for finding jobs. Its range of groups is also considered 
valuable 

Mentimeter Mentimeter is a cloud-based tool that lets you engage and interact with your audience 
in real-time. You set the questions and your audience can give their input via a 
mobile phone or any other Internet connected device. 
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Ning Ning allows anyone to create a personalized social network, which can be great for 
both teachers and students alike. 

OpenStudy Encourage your students to work together to learn class material by using a social 
study site like OpenStudy. 

Outlook Outlook is the email client within the Microsoft Office suite. 
Padlet Padlet, previously known as Wallwisher,is an online noticeboard, which means it can 

be used for making announcements, keeping notes and online brainstorming 
Pinterest You can pin just about any image you find interesting on this site, but many teachers 

are using it as a place to collect great lesson plans, projects, and inspirational. This 
visual bookmarking site has proved very popular as a way of saving images together 
with links to resources. 

Poll 
Everywhere 

Poll Everywhere is an easy way to gather live responses in any venue: conferences, 
presentations, classrooms, etc – using SMS, web, or Twitter. 

Quora While Quora is used for a wide range of purposes, it can be a great tool for educators. 
It can be used to connect with other professionals or to engage students in discussion 
after class. 

Schoology Through this social site, teachers can manage lessons, engage students, share content, 
and connect with other educators. 
Schoology is a course management system and social network for K-12 schools and 
higher education institutions focused on collaboration, that allows users to create, 
manage, and share academic content. 

Scoopit Scoopit is a social media publishing platform where users curate content on their 
favourite topics and share it as a visual magazine. 

SharePoint SharePoint  is  an  integrated  suite  of  products  from  Microsoft  to  create a  social 
intranet and collaboration portal. 

Skype Skype can be a great tool for keeping in touch with other educators or even attending 
meetings online. Even cooler, it can help teachers to connect with other classrooms, 
even those in other countries. Skype is useful for one-to-one interactions as well as 
group conversations. Skype for Business (previously Lync), means it is also a key 
enterprise tool, and Skype in the Classroom a key educational tool. 

Slack Slack is a team collaboration tool, for real time messaging and file sharing 

ThingLink ThingLink is an interactive media platform that empowers publishers, educators, 
brands, and bloggers to create more engaging content by adding rich media links to 
photos and videos. 

Todays 
Meet 

TodaysMeet lets you set up a backchannel for an event. It gives you a private chat 
room where you and your audience can have a conversation together. 

Trello Trello is a fast and easy way organize anything – from your day-to-day work, to a 
personal project. It is available for both personal and collaborative use. 

Tweetdeck TweetDeck, now owned by Twitter, is a personal social media dashboard for staying 
in touch with what’s happening and connecting you with your contacts on Twitter. 
Available for Web and smartphones. 

Twitter There are so many ways Twitter can be used in education. Teachers can connect with 
other educators, take part in chats, share their ideas, or even use it in the classroom to 
reach out to students. Twitter is seen as a prime place for professional networking, 
for news and updates for use as a backchannel in conferences and for real-time chats 
using hashtags. 

Vimeo Vimeo is a video-sharing website where users can upload, view and share videos. 

WebEx Cisco WebEx is web conferencing and meeting software that  combines file and 
presentation sharing with voice, HD video and meeting spaces. 
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WhatsApp Not just a personal messaging app, but its broadcasting and group functionalities 
make it a valuable tool both for educational and corporate activities. 

Wikispaces Share lessons, media, and other materials online with your students, or let them 
collaborate to build their own educational wiki on Wikispaces. 

WordPress WordPress is a very valuable tool for a number of reasons. It is used by individuals 
and organizations for blogging, but also to create fully-functioning websites – due to 
the powerful range of 3rd party plugins 

Yammer Microsoft’s Enterprise Social  Networking platform has  become  a  popular  social 
collaboration and knowledge sharing platform both in businesses and education. 

 

At the other side learning is at some level a social enterprise that relies in part on the 
formation of a community (Duderstadt, 2009) [8]. The research of Minamino and Kinoshita 
(2010) studies that the students were able to exchange ideas to one another and compete with 
others in finding good points of evaluated member idea based on web-based system [9]. 
Additionally, the open educational resources system developed into online system could 
support the students the development of thinking, and then they could exchange it so that its 
conclusions were made at anytime and anywhere (Dina and Ciornei, 2015) [7]. Thus is related 
to the social collaboration, Social Learning, which is most known technic in OER. 

Almost each tool for Delivery of Learning Content category contents some form of 
Content-based resource. The last is integrated with authoring of course. There are some good 
examples (24 tools) of Delivery of Learning Content shown in Table 4. 
Table 4: Delivery of Learning Content 

 
Tool Name Description 

MasteryConnect Through MasteryConnect’s MasteryTracker, teachers can effectively  assess 
core standards, monitor student performance, and report student mastery to 
parents and administrators. MasterConnect makes it simple to track  and analyze 
both, as well as other elements of student performance. 

Blackboard 
Learn 

Blackboard Learn is an educational learning management system – part of a 
suite of educational tools from Blackboard. 

Canvas Canvas   is   a   new   style  course   management   system  that   is   adaptable, 
customizable, easy to use and mobile. 

Capzles Capzles makes it simple to gather media like photos, videos, documents, and 
even blog posts into one place, making it perfect for teaching, learning, or 
online projects. 

CarrotSticks On this site, teachers can take advantage of a wide range of math learning 
games, giving students practice while they have fun. 

Coursera Coursera is an education company that partners with top universities and other 
organizations to offer online courses for free. 

Creaza Creaza can make that possible, offering tool to brainstorm, create cartoons, and 
edit audio and video. 

edX edX is a MOOC provider. It hosts online university-level courses in a wide 
range of disciplines including some at no charge. 

iPad and Apps One of the most widely used, though expensive, tech tools being used in today’s 
classroom is the Apple iPad. With a host of educational apps being developed 
for the device, it’s become a favorite of teachers and students alike across the 
nation. Apple’s iPad together with the huge range of apps available for it – 
some of which have their own entries on the list – make it a very popular 
“learning” device. It is the most popular tablet on the list. 
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Keynote This is Apple’s presentation software for all Mac and iOS platforms. Keynote 
presentations can easily be controlled using an iPhone, iPad or even the Apple 
Watch. 

Khan Academy Many teachers use this excellent collection of math, science, and finance lectures    
and    quizzes    to    supplement    their    classroom    materials. Khan Academy 
is a popular learning platform with an extensive library of courses to learn 
about math, science, economics, finance, computing and other topics 

Kindle & App Kindle is a series of e-reader devices developed by Amazon. Kindle desktop 
and mobile apps are also available so that you don’t need a device to read a 
Kindle book. 

Knewton Adaptive learning has been a hot topic in recent months, and with Knewton it’s 
something that any teacher can access and use. The site personalizes online 
learning content for each student according to his or her needs. 

Mentor Mob On Mentor Mob, you or your students can create a learning playlist, which is 
essentially a collection of high-quality materials that can be used to study a 
specific concept. 

Moodle Moodle has been on the list for a long time. Although it still has plenty of fans. 
there are others who think it is now showing its age. 

Nearpod Nearpod lets you present, quiz and report synchronously with your students or 
else make content available on demand. 

Planboard Make sure your lessons are organized and that your day runs smoothly with the 
help of this amazing online tool designed just for teachers. 

QR Codes QR codes (or quick response codes) are showing up with greater frequency in 
education. If you’d like to get in on the trend, you’ll need a tool to create and 
manage the codes like Delivr and one to read codes, like any of those listed on 
this site. 

Quizlet Quizlet makes it easy for teachers to create study tools for students, especially 
flashcards that can make memorizing important information a snap. Quizlet is a 
website providing learning tools for students, including flashcards, study and 
game modes. 

SlideShare With SlideShare, you can upload your presentations, documents, and videos 
and share them with students and colleagues. Even better, you can take 
advantage   of   materials   that   other   have   uploaded   as    well. Slideshare 
is still the most popular place to find, as well as host presentation slidesets as 
well as other documents and infographics. Owned by LinkedIn. 

StudySync With a digital library, weekly writing practice, online writing and peer reviews, 
Common Core assignments, and multimedia lessons available, this site is a 
fully-featured tool for teaching and learning that can be a big help in the 
classroom. 

TED Talks/Ed TED isn’t just a great place to find inspiration anymore, the site also contains 
numerous videos that are organized by subject and can help you to teach 
everything  from  how  pain  relievers  work  to   Shakespearean   insults. TED 
is a non-profit devoted to Ideas Worth Spreading – annual conferences, the 
annual TED Prize and local TEDx events. TED Ed is a tool to create 
lessons around TED Talks and other videos 

Udemy Unlike academic MOOC programs, Udemy provides a platform for experts of 
any kind to create courses. 

Wikipedia Wikipedia is as a key resource for quickly finding out about a topic, and then 
for delving into primary resources for deeper information 
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Delivery of  Learning  Content  category could  be  divided  into  following  sections: 
Learning, Lesson Planning and Tools and Useful Tools. 

The last category is Evaluation Activity where we found only 3 tools – Table 5. 
 

Table 5: Evaluation Activity 
 

Tool Name Description 
Kahoot Kahoot is a game-based classroom response system – for schools, universities 

and businesses. 
Socrative Available for computers, mobile devices, and tablets, this student response system 

engages students through games and exercises on any device they have on hand. 
Even better, teachers can easily assess student progress and  track grades. 

SurveyMonkey SurveyMonkey is an online survey tool. It allows users to design surveys, collect 
responses, and analyse the responses of their created surveys. Users can also get 
access to survey questions and professional templates 

 

To select a suitable tool will look at criteria that relate to the basic definition of the 
term. One of the important characteristics any OER is "reside in the public domain or under 
an open license." For this reason, one of the criteria would be the type of accessibility tool 
OER, mainly interested in online tools. The second criteria is related with the definition of 
"permit no-cost access, use, adaptation and redistribution by others with no or limited 
restrictions" therefore particularly important is what the OER tools license and cost. Not least 
is better to address new and innovative OER tools, i.e. during the last 1-2 years. Therefore we 
chose the following three criteria for OER analysis: Availability, Cost and New. 

2.5. Choice of suitable OER tools 
The Fig 2 shows the information of selected OER tools based on first criteria 

“Availability”. 
 

 

Fig. 2: Availability of OER tools 
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The 94 of the all tools are availability by Internet (Online): 40 tools are form Dialogue 
&  Collaborative  category;  33  form  Content-based  resources  category;  18  -  Delivery  of 
Learning Content and 3 - Evaluation Activity. 

The second criterion is cost of the chosen OER tools which are shown in Fig. 3. 
 
 

 
 

Fig. 3: Cost of OER tools 

There are 90 free tools, but 31 have limited version which is free and the most 
functionalities are paid. In Dialogue & Collaborative category are 36 tools; Content-based 
resources are 35 tools; Delivery of Learning Content – 16 tools and Evaluation Activity - 3 
tools. 

The table 6 shows the tools which are from the last years. 
 

Table 6: New OER tools 
 

Tool Name Type Cost Availability 

Canva Content-based resources Free and premium plans Online and iPad app 

edX Delivery of Learning 
Content Free and premium. Online 

GoAnimate Content-based resources Commercial.  Free trial. Online 

Mentimeter Dialogue & Collaborative Free and premium plans. Online 

Office Mix Content-based resources Free. Download for 
PowerPoint 13 

Padlet Dialogue & Collaborative Free. Online 

Piktochart Content-based resources Free and premium plans. Online 

Slack Dialogue & Collaborative Free and paid plans. Online 

Sway Content-based resources Free. Online 

ThingLink Dialogue & Collaborative Free and premium plans. Hosted 
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Udemy Delivery of Learning 
Content Free. Free and paid for 

courses. 

Udutu Content-based resources Free. Hosting per screen 
charge. Online 

Videoscribe Content-based resources Commercial. Free trial. Download 

2.6. Conclusion 
In the end of this research four temporary OER creation tools have been selected for 

the education of the school teachers that are partners in this project. 
The chosen tools for OER creation are: 

 
1. Windows Movie Maker 
2. EduBlogs 
3. CamStudio 
4. EasyTestMaker 

 
These tools are convenient for use in each school subject and are easy to learn and to use. 

Additionally these tools are free for download and to use. Except the included guides for the 
tools use there are a lot of guides and tutorials in the Web. 
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3. OER tutorial 
In this chapter the definition, goals, benefits, the main characteristics and the tools and 

methods for chosen OER use are described. 

3.1. Windows Movie Maker OER Tool 
3.1.1. What is Windows Movie Maker 
Window Movie Maker (WMM) is a free program that can be used to edit video clips and 

combine clips from a variety of sources into a single video clip. WMM allows you to easily 
turn photos and videos into movies to share with friends across a TV, PC or mobile device 
using the most popular camera types and file formats on the market today. 

3.1.2. Goals of the Windows Movie Maker 
The goal of the WMM is to provide users with a possibly the simplest way to combine 

video clips into a presentable digital movie. WMM supports the well-known image and video 
files as: Windows Media Video (WMV), Windows Media, DV-AVI, Microsoft Recorded TV 
Show, QuickTime MOV, QT,3GP, 3GPP, MPEG-1, MPEG-2, MPEG-4, AVCHD, Motion 
JPEG, JPEG, TIFF, GIF, Bitmap, PNG. 

3.1.3. Benefits of Using Windows Movie Maker in Education 

• Ultimate in easy of organize and select the photos and videos you want to use in the 
movie. 

• Ultimate in ease-of use for video editing. 
• Stabilization. 
• Choice of transitions. 
• Auto preview of effects. 
• Voiceovers and other audio features. 
• Good sharing optionsincluding YouTube, Facebook, Windows Live SkyDrive, and 

many others. 

3.1.4. How to use Windows Movie Maker [26, 27, 28, 29, 30, 31] 
Getting Windows Movie Maker - Download the WMM for free [25]. WMM is a part of the 
Windows Live Essentials (select Choose the programs you want to install and choose to 
install Windows Live Movie Maker and any other Windows Live applications. To install 
Movie Maker only, deselect the other boxes. 
Launch WMM: 
Ribbon – the region with editing tools. 
Preview window – the window where you view the video playback of your project. With 
Play buttons you can rewind, fast forward or play the video. You can also Toggle full screen 
view for your preview. Slider indicates where in the track you are. 
Storyboard/Timeline window – the window of the video sequence; contains your imported 
video clips; you can navigate through the clips, split them and arrange them in the sequence. 
Zoom bar – you can take a closer look at your film strip. 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

21 

 

 

 
 

 
 

1. Start a new project and save the project 

• File > New project File > Save project as 
 
 
 
 
 
 
 
 

Select the Videos directory, name 
the project Test.wlmp and click 
Save. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Import video files 

• Home > Add videos and photos 

Preview window 

Ribbon 

Storyboard/Timeline window 

Slider Toggle 

Play buttons Zoom bar 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

22 

 

 

 
 

 
 

• Import the video file Wildlife.wmv from Videos directory. 
 

 
 

Video Tools menu appears. Text Tools menu appears (the file contains captions). 
 
 

 
 
 

3. Save the movie 

 
 
 
 
 
 

Vertical  bar  –  drag  the  bar  to  navigate 
through the clip sequence. 
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• File > Save movie > For computer 
 

 
 

 Save the movie file Test.wmv as type Windows Media Video File (*.wmv) in 
Videos directory. Save project saves the editing progress; Save movie saves the 
project as a video. 

 
4. Edit video files 

 

 
 

• Trim clips – this is useful if you want to hide any unwanted parts of the video– for 
instance when there is blank space on the front and tail end of your video clip, or if 
you only want to take a brief scene out of a larger video. 

 

 

 
 
 
 

23 
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 Select a clip. 

 Video Tools > Edit >Trim tool 
 Set start and end points 

We want to trim a little space on the front and tail of the video. Drag the slider to 
set the new start (1.00) and end points (29.00) – for precise navigation use frame- 
forward and frame-back buttons. You either can define the start and end points 
with the vertical bar and Set start point and Set end point buttons or type the start 
and end point times manually. 

 

 
 
 
 

 
 

The unwanted front and tail of the video are trimmed. 
 Save trim – saves the start and end points and closes the trim tool. 

WMM does not delete the trimmed part of the clip, but hides the trimmed part and 
will not show up during playback. 

 Save the project (Test.wlmp). 
 Save the movie (Test.wmv). 

• Split clips – this is useful if you want to insert either a picture or a video transitions in 
the middle of the clip. 
 Select a clip. 
 Find the point (16.33) with the slider where you want to divide the long clip into 

two items – either drag the black vertical  bar  or  play  the  video  and  hit stop. 

 
 
 

 Video Tools > Edit > Split 
 
 
 

The clip is divided into two items at the choosing point. 

1.00 29.00 

16.33 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

25 

 

 

 
 
 

 
Add pictures 

 

 Add the audio track of your video as music. 

− Home>Add music>Add music 
 
 

 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

26 

 

 

 
 

 
 

Music Tools menu appears. 
 

 
 
 
 
 

 Mute the audio on your video 

− Select the video clip. 

− Home >Edit > Video volume > slide the slider all the way to the left. 

2. Select the video file. 

1. From drop-down menu select Audio and Video. 
Test.wmv 

3. Click the Open button. 

 
 
 
 
 
 
 

A green audio bar appears that is lined up with 
your original video. 
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 Define the segment in your video where you want to put the picture in. 

− As a start point of the segment use the already created point 16.33. 

− Split the video to the end point 19.87. 
 

video segment 
 

 
 

− Hover your cursor over the segment until an information window pops up and 
take not about duration. 

− Delete this segment of the video (select the segment and hit Delete key). 
 Insert a picture 

− Home > Add videos and photos 
 

 
 

− Insert the picture file Koala.jpg from Pictures directory. 
 Drag the picture to space were you deleted the segment. 
 Select the picture. 

16.33 19.87 

− 
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Text Tools menu appears. 

 
 

 Edit > type the duration. 
 

 
 

 
 
You can add transitions between clips (Animation > choose one from Transitions), 
rearrange the clip sequence (drag and drop the clips) or delete a clip (select the clip and hit 
Delete key). 

5. Titles, captions and credits  

• Add title page/caption/credits 
Home >Title A black page is added in front of the selected clip. 

Home > Caption A text box is inserted over the top of an existing clip. 

Home > Credits > Credits | Director | Starring | Location | Soundtrack 

Pages are added to the end of the sequence. 

 
 
 
 
 
 
 
 
 
 

 
 

 Enter the text in the text box. 
 Change the text font (family, size, color), paragraph (transparency, aligns), adjusts 

and effects. 
 Choose an effect. 
 Save title/caption/credits – click out of the slide/click outside the text box/click out 

of the slide. 
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 Enter the text in the text box. 
 

 
 

 Select the title. 
 Choose the effect Cinematic – burst 1 from Text Tools > Effects. 

 

 
 

 Drag the green bar under your video clip to be aligned with the beginning of the 
original video or from Music Tools menu click the Set start time button to set the 
time manually. 

• Add a title 

Title 
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 Save the title. 
 

• Add a caption 
 

 Select the picture. 
 Enter the text in the text box. 

Caption 
 

 
 

 Save the caption. 

• Add credits 
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 Enter the text in the text box. 
 
 
 

 
 

 Save the credits. 

• Edit titles/captions/credits 
 Double click on the title/caption/credit which is seen below the video/picture. 
 The text box appears. 
 Modify the text in the text box. 
 Change duration – select Start time and change Text duration. 

 Save title/caption/credits – click out of the slide/click outside the text box/ click 
out of the slide. 

Credits 
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• Add music 
 

 
 

 
 
 

 Home > Add music > Add music 
 

 
 

− Choose Kalimba.mp3. 

• The music clip is added after the last item. 
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• Drag the green bar under your video clip to be aligned with the title of the video 
and from Music Tools menu click the Set start time and Set end point buttons to 
set the starting time and the duration manually. 

 

 
 

 
 

• Home > Add music > Add music 

− Choose Sleep Away.mp3. 

• The music clip is added after the last item. 

Added video clip Kalimba.mp3 

Kalimba.mp3 
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• Add soundtrack 
 

• Home >Credits > Soundtrack 
 

 
 

Automatically a soundtrack page with the added songs is added to the end of the 
sequence. 

 

 
 

Save the project and the video 
Publish the video film 

Added video clip Sleep Away.mp3 

Soundtrack 
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• Home > choose one publishing option from Share. 
 

 
 

You may choose YouTube (if you have an account), or any other type available. 
 
3.2. EduBlogs OER tool 

3.2.1. uBlogs 
Edublogs are: Safe and Reliable – Blogs can be completely private or open to the public. 

Since we only host education related content, Edublogs are allowed by most school filters 
where other blogging platforms are not; Student Friendly – It is as simple to add to and update 
a blog as it is to send an email. Teachers can easily create and manage as many student blogs 
as needed; Rich With Features – A few of the most popular features include discussion tools, 
video embedding, Facebook and Twitter integration, and calendars; Customizable – With over 
100 different themes which allow for control of colors, images, and layout; Research-Based – 
Engage students in their learning and enhance instruction through collaboration, student 
portfolios, and endless classroom uses [32, 33]. 

3.2.2. Goals of the EduBlogs 
The goals of academic blogging are : create a set of “best practices” for instructors who 

wish to integrate blogging into their courses; develop guidelines for students who engage in 
academic blogging; and identify the level and kind of IT support necessary to optimize 
academic blogging [34]. 

3.2.3. Benefits of Using EduBlogs 
Initial studies of academic blogging have shown important educational benefits for student 

bloggers. These benefits include increased opportunities for self-expression, positive 
reinforcement of course material, enhanced capacities for critical self-reflection, and deeper 
engagement with concepts and ideas. Faculty members who assign blogs in their courses can 
facilitate dialogue outside of the classroom, thereby expanding the learning community and 
experience in meaningful ways [34]. 

3.2.4. How to use EduBlogs 

• Fill  all  fields  to  create  your  account  Edublogs  is  the  largest  education  blogging 
platform on the web [35]. 

• It's easy, safe and packed with features. 
• WordPress powered blogs, eportfolios, and websites. 
• Edublogs is a blog created for educational purposes. 

 
Visit site: http://edublogs.org/ 

http://edublogs.org/
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Step 1: Create blog and log in 
 
 
 
 
 
 
 
 
 
 

Write your user name and password 
 
 
 
 
 
 
 
 

Select user role: student or educator 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setup blog domain and title as fill the fields. 
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Login into system using your username and password. 
 
 
 

Step 2: Visit for first time your blog 
 

After login you can see “Dashboard” which shows you an at-a-glance look at your recent 
activity, including how many posts, comments and pages you have. 

 

 
 
There are two menus: context and main menu: 
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Select menu My site -> Visit Site to see your blog 
 

 
 
 
 
Blog site: 
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Step 3: Customize the look of your blog 

 
Select menu option Customize 

 

 

You can use left menu to change interface of your blog: 
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To change blog title and tagline, you can use Site identity menu option: 

 

 
 
 

Click Save & Publish button to save changes.  
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The next section is to change header text color: 

 
 
 
 

You can upload new header’s pictures: 
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The Widgets -> Main sidebar menu is used to customize left column elements: 

 
 

The Widgets -> 3 Col Right Sidebar menu is used to customize 3th right column elements: 
 

 
 
Select component to add right side of the blog: 
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Step 4: Edit page and post 
 
To edit page select Pages -> All pages option in left main menu 

 

 
 
You can see list with all pages show on the screen. Select Edit option for page, which you 
want to edit: 

 

 
 
The selected page appear at screen and you can edit title and text for your page: 
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You can add media (image, video, audio) in your page. Select Add Media button. 
 

 
 

  



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

45 

 

 

 
You can drag and drop your file(s) or select them from computer: 

 

 
 

To save page changes select Update button on the right site in your screen: 
 

 
 

To edit page select Pages -> All Posts option in left main menu 
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You can see list with all posts show on the screen. Select Edit option for page, which you 
want to edit: 

 

 
 

The selected post appear at screen and you can edit title and text for your page: 
 

 
 
 

You can add media (image, video, audio) in your post. Select Add Media button and drag 
and drop your file(s) or select them from computer. 
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The all posts have category which you define as checked in category panel. You can add 

new category as select Add New Category button on right site: 
 

 
 

To save page changes select Update button on the right site in your screen: 
 

 
 
Step 5: Set status and visibility on my blog posts and pages 
Status: 

• Draft: Typically used for posts which haven’t been finished yet, the author is still 
working on them. 

• Pending Review: Typically used for posts which need to be reviewed by an editor 
before publishing. 

• Publish: Under publish, you have the option to set the date for your post. By default, 
this will be set to the current date and time, but you can change this to post in the past 
(perhaps for historic events which weren’t posted at the time), or the future, which 
will schedule them for release on that date. 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

48 

 

 

 
 

 
 

Visibility: 
• Public: Public posts are available to all visitors to the website, as well as search 

engines. 
• Stick this post to the front page: ‘Sticky’ posts, as they’re called, will always 

appear at the top of your post lists (your blog page, recent posts, etc.). 
• Password Protected: Password protected posts will require visitors to enter the 

correct password to view. This will be the same password for every visitor. 
• Private: Private posts are only visible to logged in visitors. The public and search 

engines will not see these posts listed anywhere. 
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3.3. CamStudio OER tool 
3.3.1. What is CamStudio 
CamStudio gives the possibilities to record all screen and audio activity on your 

computer and create industry standard AVI video files and using its built-in SWF Producer 
can turn those AVIs into appropriate friendly Streaming Flash videos (SWFs). CamStudio 
is a free software program that gives you the freedom to record all screen and audio 
activity on your computer. CamStudio can take the inputs and turns it into an AVI video 
file or Streaming Flash Videos (SWFs) that you can use it to upload it either in your 
classroom website or in YouTube. 

3.3.2. Goals of the CamStudio 

• Screen captures 
• Voice recordings 
• Anti- aliased screen captions 
• Picture in picture for webcam recordings 
• Open-source application (most accessible) 

3.3.3. Benefits of Using CamStudio 
CamStudio is one of the top 3 e- learning tools and is an obvious choice for a simple e- 

learning project. It is a screen casting tool that provide easy production of lecture videos 
and it could be used for the process of teaching and learning. CamStudio make a picture of 
a user’s screen as a screencast that is a movie of what a user sees on their monitor. 

You can use it to: 
• Introduce lessons to watch before classes 
• Create video tutorials for school or college 
• Create demonstration videos for any software program 
• Create tutorials integrated with problem solving practice 
• Make a record of a class session as a study aid 
• Assign students an assignment to create a screencast on a curriculum topic 

(another form of presentation). 
• Create a set of videos to answer your most frequently asked questions. 

3.3.4.  How to use CamStudio [36][37][38][39][40][41] 

Getting CamStudio: 

Download CamStudio from http://camstudio.org it is absolutely free. 
Click on CamStudio.exe and Save or Run the “.exe” file. 
The installation is completed for less than 2 minutes. 
Launch CamStudio 

The basic operations of CamStudio are surrounded with red quadrangle in Fig.1. 
- Click record to begin recoding. 
- Click pause to pause recording. 
- Click stop to stop recording. 

http://camstudio.org/
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Fig.1- CamStudio software 

Screen region menu options. 

The Region tab from the menu allows you to set what part of your screen you 
wish to record Fig.2. 

 
Fig.2- Region menu of CamStudio 

There are three basic settings: 
• Region- allows you to set the size of the recorded area- shown in Fig.2.1 

 

Fig.2.1- Enable fixed region function 

• Fixed region- allows you to present the size of the recorded area- shown in 
Fig.2.2 
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Fig.2.2- Fixed region window 

• Full screen – captures the whole screen- Fig.2.3. 
When screen size is larger the resolution and viewability is decreased, so it is better 

to choose the screen size that suits your needs. 
 

 
Fig.2.3- Enable full screen video function 

The Option tab in the menu of CamStudio 

Enable Autopan from Option tab in the menu: 

If you set a region that does not show the full screen, you can still show the full 
screen by having the region follow your mouse cursor. This is called AutoPanning function 
of CamStudio Fig.3. 
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Fig.3- Function of CamStudio enable AutoPanning 

To enable this you can click to the option enable Autopan. You can also change the 
speed of the autopan by clicking on Autopan speed. Autopan speed panel is shown in 
Fig.4. But also, the default setting work well. 

 

 
Fig.4- Autopan Speed from Option menu 

Recording audio options from Option tab in the menu: 

CamStudio allows you to record audio from two sources Fig.5. 

 
Fig.5- CamStudio recording options 
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You can choose between the following options for recording: 
- Do not record audio - Makes silent animations, useful if you don’t like listening to 

your voice 
- Record audio from microphone- Records sound using a microphone, useful if you 

want to narrate your animation 
- Record audio from speakers- Records audio that is coming from your computer 

speakers, useful if you want to record an online video to your computer (ex.YouTube 
video). 

The Audio Options function allows you to choose the microphone to record from, 
volume settings, recording format, etc… You can use the default settings except for 
choosing your microphone. For Audio Options you can download and use CamStudio 
Lossless codec that reduce the size of the video, so that you can upload your video for 
example in Youtube. 

 

Cursor options from Option menu: 

The Cursor options dialog is shown in Fig.6. 
 

 
Fig.6- Cursor options dialog from Option menu 

Cursor options can be used to make the cursor more visible in the video during 
recording. You can change the size, the color and the shape of the cursor or you can choose 
to remove the cursor completely. It is important to mention that the cursor is visible only 
during playback but not during recording. The options allows you to: 

- Hide cursor- Make your cursor invisible during playback 
- Use actual versus a custom cursor – Allows you to use the normal arrow 

cursor, or change it to a custom shaped cursor if you have a file for it. 
- Highlight cursor- it make the cursor more visible 
- A “Size” slider bar allows you to change the size of the highlight 
- A “Shape” drop down menu allows you to change the size of the highlight 
- A “Color” button allows you to change the color of the highlight 

A preview box shows you what the cursor will look like during playback. 
 

How to hide CamStudio program during recording? 
 

It will be easier to make the video, if CamStudio is minimized during recording and 
it is not visible. This is shown in Fig.7. You can set CamStudio to do this automatically. In 
the Option tab, move your cursor over the Program Options, then click on Minimize 
program on start recording. A check mark will indicate that this option is selected. Now, 
when you start recording, the program will be minimize automatically. Possible problem 
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that could arise, when you minimize the program is to stop recording. There are two 
options to maximize the program and stop recording either from the icon in the task bar or 
you can use the keyboard. Under the Options tab, when you click on Keyboard Shortcuts 
you can view the current keyboard shortcuts. Here are the default settings: 

F8:Record/Pause 
F9:Stop 
F10:Cancel Recording 
You have the option of changing the shortcuts to any key you desire. 

 

 
Fig.7- Program Options for CamStudio 

Saving video file 

When you click on stop button automatically is opening a dialog for saving the file 
in AVI or SWF file and it save the videos in My CamStudio Videos folder. This is shown 
in Fig.8. 

 

 
Fig.8- Saving CamStudio video 
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3.4. EasyTestMaker OER tool 

3.4.1. What is EasyTestMaker 
EasyTestMaker is an online test generator to help you create and manage your tests. There 

are possibilities for creating, printing and publishing your tests online. EasyTestMaker makes 
it easy for you to perfectly format multiple question types, print alternate versions, and 
publish to the web for online tests. Online tests are automatically graded. Published online 
tests are graded automatically. View and print student's results and override grading when 
necessary. The same test you print is the same test you publish online. Alternate versions and 
answer sheets provided with no extra work. Questions and answer choices are automatically 
resorted in a different order. 

All question types available: multiple choice, fill-in-the-blank, matching, short answer and 
true or false questions. Add instructions and divide your test into multiple sections. 

EasyTestMaker eliminates wasted time spent on formatting. Add new questions and 
sections, move them around as needed and let EasyTestMaker do the hard work for you. All 
your tests are saved for easy retrieval. You can make changes or print out additional copies of 
any test you create. 

Free, Plus and Premium plans are available [42]. 

3.4.2. Goals of the EasyTestMaker 
The goals of EasyTestMaker are: Create, print and publish your tests online! 

EasyTestMaker makes it easy for you to perfectly format multiple question types, print 
alternate versions, and publish to the web for online tests. Online tests are automatically 
graded! [42]. 

3.4.3. Benefits of Using EasyTestMaker 
EasyTestMaker is very convenient, since it is very simple to use. There is no trouble at all 

creating a test and an answer key without looking at any tutorial or reading instructions. That 
tool is simple and self-explanatory. 

Making tests online can be a very nice solution to reduce paper copies that are only going 
to serve once. 

Furthermore, any tool that allows saving time always has a great place. Having tests 
automatically corrected is useful. [43]. 

3.4.4. How to use EasyTestMaker [42,44,45] 
Go to the website:  http://www.easytestmaker.com 

http://www.easytestmaker.com/
http://www.easytestmaker.com/
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You have to be registered. During the signing process you have to select your plan. 
 

 

3. Sign up complete. Click on the button Log in. 
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Log in – enter your username and password. 
 

 

First page. Now you can create your first test clicking on the link Click here. 
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Creating new test. In order to create new test you have to type the test name. In the example 
the test name is Bioinformatics. 

 

 
 
Menu: 
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Creating a question. In order to create a question you have to select any question type from 
the menu. 

 

 
 
Available question types: 

 
• Short Answer 
• Multiple Choices 
• True/False 
• Matching 
• Fill in the blank 
• Section Heading 
• Copy Question 

 
Question type Multiple Choice – one correct answer. Type the question and both true and 

false answers. Then mark the correct answer. Point Value can be between 1.00 and 99.99. 
Click on the button Ok to complete the question. 
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Question type Multiple Choice – Multiple options required for correct answer. Type 
the question and both true and false answers. Then mark the correct answers. Point Value can 
be between 1.00 and 99.99. Click on the button Ok to complete the question. 
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Fill in the blank. Surround your fill-in-the-blank word with brackets "[]". Example: 
Bioinformatics is focused on development of practical [tools] for managing and analyzing 
[data]. Click on the button Ok to complete the question. 
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Matching. Enter options on left and answer on the right of the same row. Choose your 
ordering or click to randomize. 

 

 
 
 

Adding a new question. Select the question type. 
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Setup/General. You can change the test name. 
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Setup->Print/Export. You can set the page margins – top, bottom, left and right and question 
spacing. 

 

 
 
 

Setup->Alternate Versions. Randomizing alternate version rules: 
• Randomize question order: Test questions will be sorted in random order when you 

download the alternate versions. When section headings are used, randomizing 
question order will automatically keep questions below each section in the same 
group. 

• Randomize multiple choice and matching options: Options for multiple choice and 
matching type questions will be sorted in random order when you download the 
alternate versions. 
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Setup -> Question Formatting: 
• Provide answer slot for Multiple Choice and True/False questions. 
• Suggestive length answer slots for Fill in the Blank questions. 
• True & False Display Values. 
• Answer Identifiers for Matching, Multiple Choice and True/False. 

 

 
 
View. Choose what you see when you are editing your test (enable or disable): 

• Show Correct Answer; 
• Show Point Values. 
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Publish the test to make it available online. Before publishing the teacher has possibilities to 
set the test characteristics, such as: 

• Availability (data range for when this test can be taken online: from - to), 
• Access Code, 
• Online Test Options, 
• Time Limit. 

 

 
 
After setting the test characteristics, the teacher has to click on the button Publish. 

 
Publishing. Your test has been published. Test link and site link are obtained. You will need 
to distribute the access link(s) to your test takers. Test and site links do not change when you 
publish updates in the future. 
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Test link. In order to make the test the student has to sign up to the test on Bioinformatics 
using First name, Last name and Access code. Time limit is 30 minutes. Then click on the 
button Start Test. 
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Test questions – 1st  question. After the student answers a question, he / she can click on the 
button Next to move to the next question. 

 

 

Test questions – 2nd question. The student can return to a previous question by clicking on the 
button Back. 
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Test questions – 3rd question. 

 

 

Test questions – 4th question. 
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Test complete. After completing the test, the student has to click on the button Finish. 
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Finish test. In case of you are sure you want to complete the test, click on the button Finish 
Test. 

 

 
 
Test results. The teacher can see the rest results by signing up using username and password. 
Click on the button Results. 

 

 
 
 
The list below shows all the students who took the test including information such: 

• Student name, 



Integrating E-Learning and Open Educational Resources into Classroom” – iOERc 

72 

 

 

 
 

• Status, 
• Grade, 
• Finished data and time , 
• Version. 

 

 
 
Detailed Test Results: Click on the button View/Edit. 
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Creating new test. To create new test, select the button Create a new test and follow the step 
6. 
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4. Conclusion 
With the use of OER the educational system undergoes a qualitative change as a result 

of changes in the way the actual content and teaching methods, and tools, environments and 
ways of disseminating knowledge. All this leads to transformation of the educational model 
which allows movement from studying ICT to learning by using ICT. The presence of a huge 
number of open educational resources with free access motivates trainers to create and use 
training courses with high quality and students may compare and evaluate the available 
teaching materials. More than 100 OER tools have been described and presented to the 
teachers. 

In this report might be summerised that the goals set for the team of the project have 
been achieved. An precise overview of used tools for the OER creation has been made and 
their application in the scholls worldwide. It has been examined the applicability of the 
different tools acording different chosen characteristics (for example their prise or 
accessibility). As it has been recommended for a greater use of ICT tools and OER in teaching 
process four tools have been selected and the school teachers that are partners in this project 
have been educated to use them. 
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